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STREETSYNC QUICK‐START 

 
 

INSTALLING STREETSYNC 
 

Installing the program is a fairly simply task with just a few straightforward steps 
to be followed.  As mentioned above, StreetSync requires Microsoft MapPoint to 
be installed on your system.  If you do have MapPoint installed you can simply 
ignore the MapPoint-related instructions.  The following steps will allow you to 
install and use StreetSync: 

 

 Install Microsoft MapPoint 2006. If you currently have MapPoint installed you’ll be able to skip 
this step. Either the full version or a 60-day trial will allow you to evaluate StreetSync. MapPoint 
has two install CDs and you’ll need to insert and run them in the correct order. Please read the 
Microsoft EULA and complete the installation wizard steps as prompted. 

 Make sure that the latest Atlas version is installed on your computer. 

 Follow this link http://www.routesolutions.com/clients/navteq/index.htm and install StreetSync 
as mentioned on the homepage. Follow the wizard steps to install the program to your preferred 
location.  

 The installation routine will create a ‘Shortcut to StreetSync’ item in your Start|Programs area.  
Click on this item to load the program for its first use. 

 Read and accept the End-User License Agreement (EULA) when prompted. Please be certain 
that you choose the correct nation from the drop-down list provided. 

 First enter your registration key (5505247466). Then enter the vehicles key (9978465). 

 The main StreetSync interface will now appear.  It is HIGHLY recommended that you complete 
the ‘Getting Started’ wizard that is presented to you at the onset and that is further explained 
below. 
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THE GETTING STARTED WIZARD 
When the program first loads, it will present a form named the ‘Getting Started’ 
wizard to assist you with entering the necessary data 

 

 

 

 

 

 

 

 

 

HOW TO COMPLETE THE WIZARD -  For each wizard step you’ll be 
given the step number and specific instructions at the top of the frame.  In step 1, 
we’ve simply explained the wizard’s purpose.  To navigate to the next step, click 
on the ‘Next’ button shown in the red box above. STEP 1 -  Read the welcome 
Instructions and click ‘Next’ to continue. 

STEP 2 – ENTER YOUR COMPANY NAME AND AREA -  StreetSync 
allows you to enter your company name ‘NAVTEQ’ to enable NAVTEQ 
specific features such as the customized import from the ATLAS program to 
appear. You can also open your map to your local geography by default.  For 
example, if your location is in Chicago, IL you can enter the text ‘Chicago, IL’ to 
cause the map to show the Chicago area by default when the program opens.  If 
you are based in Chicago but your coverage is all of Illinois, then you could type 
in the text ‘Illinois’ to frame the map to this larger geography by default. 
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STEP 3 -  ENTER YOUR INTERNAL LOCATIONS  - It is necessary to 
enter at least one location, likely your office address, into the system.  This 
location is then used as a start and end location, for instance, for your vehicle 
routes.  Click on the single button on this frame to enter the location(s).  A 
unique name will be suggested for your new location but we advise you to 
rename the location to something more meaningful to you such as ‘Central 
Warehouse’.  You’ll need to enter a street location and once you click ‘Save’ the 
address should also appear in the ‘Digital Address Match’ area to the right.  This 
will give you positive feedback that the address has been located on the digital 
map.  Keep in mind that we’re adding a location.  This type of form is known 
within StreetSync as a ‘Manager’ form.  We’ll discuss the use and capabilities of 
these manager forms in greater detail later in this chapter. 

 

 

 

 

 

 

 

 

STEP 4 -  ENTER VEHICLES .  Vehicles act as route templates within 
StreetSync.  Typically, you’ll want to enter one vehicle for each physical vehicle 
you have in your fleet.  It’s usually best to utilize a logical naming and 
symbolization standard for your vehicles.  By clicking ‘New’, entering information 
and then clicking ‘Save’, you can continue to add vehicles until you’ve modeled 
your entire real-world fleet. 
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STEP 5 -  CREATE A SOLUTION FOLDER .  Solution folders are 
containers that hold associated locations, vehicles (routes) and stops for any 
particular routing problem to be solved.  Typically a solution folder is devoted to 
a portion of a larger problem such as containing just the stops for a given day or a 
chosen postal code.  Solution folders allow you to solve large problems is smaller 
more manageable portions.  Folders also allow you to try different what-if 
scenarios to compare results side-by-side to assist you with managerial decision 
making.  For this step, simply name a folder something of your choice and click 
‘Next’. 

STEP 6 – ADD STOPS .  At this point you don’t need to continue with the 
wizard. You can finish by just clicking on the next button and end the wizard by 
clicking the finish button after the additional tips. (Unlike typical users, we’ve 
created special import tools for Navteq users to allow you to easily pull-in data 
from Atlas.) 

IMPORTING STOPS 
StreetSync makes it very easy for Navteq to import data from Atlas via a simple 
two-click process. Before you can import the stops into StreetSync you will have 
to export your data from Atlas.  The MRs on-screen will be sent to StreetSync. 
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Within StreetSync simply click on the ‘Navteq Tools’ in the menu bar and click 
the option named ‘Import Items from Atlas’.   

 

 

 
ROUTE CREATION & EDITING 
StreetSync will automatically create a folder for you as it is importing your stops 
from Atlas. You will see that StreetSync put your stops in the Unrouted Stops 
overview. You can now go ahead and start to route your stops.  

 

 

 

 

 

You can always create new folders to represent unique routing solutions.  Before 
you can route within a folder, you need to verify that the folder has routes present 
within it.  When a folder is created, the routes are typically automatically created 
from the list of vehicles present in the system.  If you ever need to manually add 
routes, you can do so by clicking on the icon shown below and choosing from 
the list of vehicles available.  If no vehicles are available, you’ll need to create 
them (see the steps to do so above).  Only vehicles not currently available in the 
folder will be listed to allow you to add them. 
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THE SOLVER MENU AND ICON GROUP 
 

Routing actions are called ‘solves’ and they’re located in the ‘Solve’ menu and in 
the ‘Solver Icons’ group.  All items concerning solving (building and editing 
routes) can be found in the solve menu and most of the corresponding items are 
located in the solver icons group.  Both are selected in this image below. 

 

 

 

 
CREATING ALL ROUTES AT ONCE 
 

Once you have your available fleet routes chosen and have all your stops 
information in place then you are ready to invoke the StreetSync solver.  The 
solver will populate all routes with their fair share of routing activity.  Again, the 
program looks to cluster stops together geographically.  This keeps overall 
miles/Kms lower and keeps your drivers from ‘owning’ too many mutual 
neighborhoods.  The solver will automatically create these geographic territories 
and will balance the activity based on the partitioning factor of your choice. 

Invoking the solver that makes all routes at once is easy to do.  You simply need 
to select the proper menu or button item as shown here. 

 

 

 

A dialog will appear and routes will be built.  Once completed you’ll see that the 
interface is updated and assignment of stops to routes occurs.  In this example 
you’ll see that the three trucks available have been given balanced stop counts and 
that all stops have been assigned.  (Zero stops remain as ‘unrouted’.)  Also, note 
that route statistics are immediately available in the ListView detail frame. 
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VIEWING A SINGLE ROUTE IN DETAIL 
 

It’s also easy to view a single map in greater detail.  Select a single route from the 
‘Selection Contents’ area and then click ‘View on Map’ from the ‘View’ menu.  
Whenever a single route is shown, the driving directions are displayed by default.   

 

 

 

 

 

 

 

 

 

 

 

 

MANUALLY EDITING INDIVIDUAL ROUTES 
 

There are several ways to manually edit existing routes.  The three ways we’ll 
discuss here are to unassign stops, reassign stops and re-sequence stops. 

REMOVING ALL STOPS FROM A ROUTE -  Select a single route from 
the ‘Selection Contents’ area and then click ‘Clear Route of Assignment(s)’ from 
the ‘Solve’ menu.  This will remove all stops for the selected route.  Note:  This 
will only move items to Unrouted and not completely delete them.  If you select 
‘Delete’ from the ‘Edit’ menu instead, then the stops will be deleted from the 
system. 

REMOVING SELECTED STOPS FROM A ROUTE -  Select one or 
more stops from the ListView area and then click ‘Unassign Selected Stop(s)’ 
from the ‘Solve’ menu.  This will remove only the selected stops currently both 
routed and selected. Note:  This will only move items to Unrouted and not 
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completely delete them.  If you select ‘Delete’ from the ‘Edit’ menu instead, then 
the stops will be deleted from the system. 

REASSIGNING ROUTED STOPS -  Reassigning stops is a simple process to 
carry-out.  First, you’ll need to select the stops that you’d like to move to another 
route.  Highlight the route containing the stops to be moved in the ‘Route 
Selector’ area.  Next, highlight the stops to be moved in the ListView.  You may 
not know the key shortcuts to select numerous list items.  You can hold down 
the [Shift] key to select multiple back-to-back items and can use the [Ctrl] key to 
select non-adjoined items as shown in our example. 

 

 

 

 

 

 

 

You’ll also see that a solver icon group item is shown in a red selection.  This is 
the ‘Reassign Selected Stop(s)’ item.  Clicking this button will launch the form to 
allow you to reassign the selected items. 

REASSIGN STOP(S) DIALOG FORM – The reassignment dialog is now 
shown.  Notice that the existing route will not be listed (you can’t reassign an item 
to the same route it’s currently on).  The route that the stops originally appear on 
is intentionally not available for selection.  Once satisfied, we click ‘OK’.  Notice 
that the stops will be subtracted from the original route and added to the newly 
selected route.  Both routes will then be recalculated due to their change in 
content. 
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RE-SEQUENCING ROUTED STOPS – Routes can have the chronological 
order of their stops manually altered and this is called re-sequencing a route.  
When you re-sequence a route, only the selected route is affected.  You are 
essentially overriding the software and forcing it to handle the route in your 
preferred stop order.  Re-sequencing is as simple as selecting a stop from the 
ListView and then clicking on the ‘Move Stop Up’ icon as shown selected below.  
This action will move the stop up (or earlier) within the route.  You can also 
perform the exact opposite action by moving a stop down (or later) within the 
route.  The ‘Move Stop Down’ button is just to the right of the ‘Move Stop Up’ 
icon.  Also, both items are available in the ‘Solve’ menu. 

 

 

 

 

USING DRAG-AND-DROP TO RE-SEQUENCE STOPS – Re-
sequencing can also be as simple as dragging and dropping the stop in the 
ListView.  Simply select a routed stop and left-click it.  While holding down, drag 
the stop item up or down in the list to move it.  When you’re ready to finalize the 
move simply let off the item, or ‘drop’ it, to complete the re-sequencing of the 
selected route stop. 

                                                       REPORTING & EXPORTING DATA 

CREATING REPORTS 
There are several ways to launch the ‘Print Reports’ form.  There is a printer icon 
that will launch the form or you can access it through the ‘Data’ menu.  This 
form will allow for the printing of reports for the current solution folder only.  
Therefore, you’ll need to be aware of your current solution folder prior to taking 
this action. 
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PRINT REPORTS FOR SELECTED ROUTES 
StreetSync allows for printing reports for individual routes.  This will allow you 
the flexibility to print a report for any combination of drivers (routes), if you’d 
like. 

CREATING REPORTS 
Several reports are available within StreetSync:    

 

. 

 

 

 

 

 

 

 

 

 

 

 

 

EXPORTING STREETSYNC INFORMATION 
StreetSync allows you to export its information directly into an Excel-readable 
format called .csv (comma separated values).  If you’re an Excel user you will be 
able to easily harness your information to create custom spreadsheets, reports and 
graphs. 

 

 

• Current Map View 

• Current Map View (Extend to Fit Page) 

• Current Selected Map Area – Only if you have a map area selected will 
this report be available. 

• Driving Directions Only  

• Turn-by-Turn Maps – Shows an image of the necessary turns to be taken 
along each route. 

• Route Overview Maps – Shows the complete path of each route on a 
single sheet. 

• Route Manifest – This report will show a basic stop-by-stop listing for all 
work to be performed for each route.  There are several manifest reports 
that contain different levels of information and are named appropriately. 

• Strip Maps – Show periodic maps and driving directions to show general 
route flow. 

• Route Summary – Shows totals for all routes within a solution folder.  
This is similar to the information displayed in the program’s list view. 
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The Export to Spreadsheet Wizard form will now be displayed.  At the onset, 
you’ll need to create a new export profile.  To do so you’ll need to click on the 
‘New’ button that is highlighted and then click on ‘Next’ to continue. 

 

 

 

 

 

 

 

The wizard will suggest a unique export name.  You are also able to type in your 
own unique name if you’d prefer. 

 

 

 

 

 

 

 

The output folder destination for the file created can be changed by clicking 
‘Browse’ and navigating to your preferred Windows directory.  Click ‘Next’ once 
you’re satisfied. 

Several other convenience options are also available to you.  You’re able to 
remove column headings in case your data workflow doesn’t allow them.  You 
can also choose if you’d like to display the file in Excel once it’s been created. 
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Lastly, you are given an option to save your newly entered profile.  If you intend 
to use this profile again you’ll want to check this option.  Once satisfied, click 
‘Finish’ and the export profile settings will be applied and your export file will be 
created. 

 

 

 

 

 

 

 

If you’ve chosen to display output then Microsoft Excel will be displayed with 
your newly exported information. All folders and all fields are exported by default 
and are sorted by solution folder, route and lastly by sequence. 

 

 

 

 

Several files are exported by StreetSync.  They include: 

 

 

 

 

 

 

 

 

 

 

 

• Routed.csv - Contains all information for currently 
routed Stops.  The output is sorted by Solution 
Folder, Route, and Sequence. 

• Unrouted.csv - Contains all information for 
currently  unrouted Stops.  Note:  Only  unrouted 
Stops with matched addresses will be included. 

• UnknownAddresses.csv - Contains all information 
for unmatched Stops that couldn't be located on the 
digital map. 

• Customers.csv - Contains all information for 
Customers currently within the system. 
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EXPORTING TO MAPPOINT FOR IN‐VEHICLE 
NAVIGATION 
 

Now that you have created route plans within StreetSync you can easily export 
those routes to MapPoint to harness the power of MapPoint’s GPS and voice 
guided capabilities.  

 

 

 

 

 

 

Click on “Export MapPoint Files” in the Tools menu as shown in the graphic 
above. 

 

 

 

 

 

 

 

 

Name your folder and select a route to add. Confirm with OK. 

Next the Windows Explorer will be launched. The windows folder name is 
identical to the StreetSync solution folder name and the file name is equal to the 
route name within StreetSync. Please open the folder and double-click the file.  

MapPoint launches and it should automatically display the route. 
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GPS TASK PANE 
 

This step will enable the GPS functionality such as voice guided turn by turn 
directions within MapPoint. The task pane will appear to the left and will display 
speed, heading, voice options, and more. Just click the GPS Task Pane in the 
Tools menu as shown below. 

 

 

 

 

 

 

 

 

Note: At this point, you’ll need to refer to the Navteq documentation that will 
outline how to install the GPSGate application that will allow Atlas and 
MapPoint to both utilize the real-time GPS feed information.   
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ADDITIONAL RESOURCES & LINKS 
 

The resources listed below will provide additional information to you: 

 

Navteq-specific install web page:  

http://www.routesolutions.com/clients/navteq/index.htm 

 

Main StreetSync online help page:  

http://www.routesolutions.com/help/streetsync/index.htm 

 

Instructional videos: 

 http://www.routesolutions.com/help/streetsync/index.htm 

 

 


